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About this document 
This section lists the audience, purpose, summary of information, and 

conventions used in this document. It also includes how to contact customer 

service. 

 

Audience 

This document is intended for certified professionals who install Firetide wireless 

solutions. 

 

Purpose 

This document has the information and procedures necessary to install and do 

basic configuration of the Firetide
® 

HotPort
® 

5020-LNK point-to-point solution. 

Conventions 

Certain information has special meaning for the reader. This information appears 

with an icon that indicates a particular condition, such as a warning or caution, 

or a label, such as “Note” or “Best Practice”. 

Electrical hazards are those environments where the danger of 

electrocution is probable. This image appears before each electrical 

hazard statement. 

Warnings contain safety information that you must obey. If you do 

not obey the instruction in a warning, the result might include serious 

injury or death. This image appears before each warning statement. 

Cautions contain information that you should obey to avoid minor 

injury, inconvenience, and damage to equipment. This image appears 

before each caution statement. 

Notes contain optional advice and information particular to a special case or 

application. 

Best practices contain specific recommendations based on industry-standard 

expectations. 

! 
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Document feedback 

If you find an error or content missing from this document, we want to hear 

about it. You can send your feedback about any of our documents to 

techpubs@firetide.com. 

 

Contacting customer support 

If you need support, depending on the problem, you might be asked for this 

information: 

• Description of the problem 

• Computer with HotView Pro and an installed management license 

• Channel and frequency plans 

• Recent spectrum analysis 

• Device topology in Google Earth (KMZ file) 

• Network map or topology plan with the names and device information 

You must also have administrator access to the mesh to be able to receive 

technical support. 

The next table lists the contact information for customer support. 

 

Worldwide customer support Days/Hours Contact 

Americas Monday to Friday 

7:00 am to 5:30 pm PST 

(Pacific standard time) 

http://www.firetide.com/requestsupport 

1 (877) FIRETIDE, extension 2 

+1 (408) 399-7771, extension 2 

+1 (408) 355-7271 

Africa Monday to Friday http://www.firetide.com/requestsupport 

 Asia 8:00 am to 5:30 pm IST +918040215111 

Australia (India standard time) Fax +1(408) 317-2257 

Europe 

mailto:techpubs@firetide.com
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HotPort 5020 point-to-point solution 
A HotPort 5020-LNK point-to-point solution is a linked pair of wireless Ethernet 

nodes that comes with outdoor-rated antennas that is ideal for data traffic. 

The nodes are lightweight, outdoor devices that give you one two-way, half- 

duplex link with UDP throughput speeds of up to 50 Mbps. Each node has one 

radio. 

Note. Do not daisy-chain pairs of devices to create a multiple hop link. 

Performance degrades if you do. 

 

The HotPort 5020-LNK node pair is managed with HotView Pro 10.9.1.0 and later. 

One node is the server; and the other node is a client. 

Applications for the HotPort-LNK nodes include: 

• Building-to-building data connectivity 

• Video surveillance with IP cameras 

• Wi-Fi access with an access point 

The next image shows a point-to-point connection with a pair of 

HotPort 5020-LNK nodes and a HotPoint 5200 access point for Wi-Fi access. At a 

distance of 1.6 km (1 mile) you can achieve data throughput of up to 50 Mbps. 
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Before you permanently install 
Before you install a HotPort 5020-LNK solution in a permanent location, you 

need to make sure you have the correct components and make sure the 

components are operational. 

 

Preparing what you need to install 

To get what you need to set up the solution: 

1. Open the box. 

2. Remove the contents. 

3. Check the contents for damage. See “Box contents for a HotPort 5020-LNK 

solution.” 

If a part is missing or damaged, call your Firetide reseller. 

4. If the contents are good and correct, keep the box for future use. 

 

Box contents for a HotPort 5020-LNK solution 

The HotPort 5020-LNK solution box contains these items: 

• Two HotPort 5020-LNK nodes with assembled mount brackets 

• Two AP20-050-MIMO-19 antennas with mount hardware 

• Two integrated 3x3 antenna cables 

• Two staging antennas 

• Two RP-SMA to type N adapters 

• Two mount brackets for 3.7 to 5.0 cm (1.5 to 2.0 inch) diameter poles or a 

wall 

• Two mount kits 

- U-bolts, M6x1.0-80mm, with flat washers, split washers, nuts 

- Claw-tooth pole grippers 

- M6x1.0-40mm hex bolt 

- M6x1.0-20mm hex bolt 

- Hex-head socket wrench 

• Two 802.3at Power over Ethernet (PoE) injectors 

• Two DC power connectors (field installable) 

• Two weatherized Ethernet RJ-45 connectors (field installable) 

• Two Cat 6 Ethernet cables, 1 meter (3 feet) 

Note. Other IEC cords are available separately. 
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• Quick start sheet 

• Warranty card 

 

Parts of a HotPort 5020-LNK node 

The next picture shows the HotPort 5020-LNK node. The LEDs are visible at the 

top of the node when it is oriented correctly for installation on a pole. 

 

 

Radio 1 LED Power LED 

 

 

1 

 

 

Radio 1 2 

3 

Radio 2 is not available 

on this model. 

 

 

 

 

The next picture shows the connectors and LEDs on the bottom panel of a 

HotPort 5020-LNK node. Weatherproof caps protect the connectors on the 

bottom panel. Rubber caps are on the antenna connectors. 

 

 

 

Rubber cap Port DC power 

 

 

 

 

 

 

Reset button 

(behind the valve) 

 

Ground screw 

 

 

 

Ground screw 

HotPort 5020-LNK nodes must be connected to earth ground. The ground screw 

is on the bottom panel between the Ethernet port and the DC power connector. 



Before you permanently install 

5 

 

 

 

LEDs 
 

The panel that has the Firetide logo has these LEDs: 

• Radio 1 and Radio 2, which indicate radio status. Radio 1 is a steady green 

color to indicate normal operation. Radio 2 should be dark because the 

HotPort 5020-LNK does not have a Radio 2. 

• Power, which is a steady green color when the device receives power. The LED 

is dark when the node does not receive power. 

 

Reset button and pressure relief valve 

The reset button is on the bottom panel and is covered by a weatherproof plastic 

pressure relief valve. 

 

Antenna connectors 

The left side panel has three antenna connectors for Radio 1. Rubber caps cover 

the antenna connectors. You must remove and discard the rubber caps when you 

install the device. For best product performance, you must connect the MIMO 

antenna cable that comes with this solution and then weatherproof all three 

connections. 

 

Firetide AP20-050-MIMO-19 antennas 

The HotPort 5020-LNK solution comes with two Firetide AP20-050-MIMO-19 

panel antennas. The next picture shows one of the antennas and its 

measurements. The antenna connectors and mount bracket are on the back of 

the antenna. 

 

 

12 mm 

(0.5 inch) 

 

 

 

305 mm 

(12 inches) 

 

 

 

 

 

 

 

305 mm 

(12 inches) 
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You can install the antennas on a pole or to a wall. Each antenna weighs 0.8 

kg (1.8 pounds) without clamps. 

Vertical polarization for this antenna is the left connector. 

For electrical and mechanical specifications, see the Firetide Antenna and 

Accessory Guides.

Test before you install 

You should set up and test the nodes indoors on a table before you install 

them in permanent locations. 

The benefits of tests before you install include: 

• Make sure all of the equipment works before you install it

• Consistent settings across nodes to reduce software configuration

errors in the field

Types of tests to do: 

• Power on each device

• Attach the staging antennas and make sure you can see the

devices in HotView Pro management software

• Data and other application throughput tests to make sure the nodes

can send and receive data

• Learn to use the radio alignment tool

• Train installation personnel

Required tools that are not included 

You need a computer that has HotView Pro network management software 

10.15.0.0 or later installed. 

Installing and configuring HotView Pro software 

HotView Pro does not support 

the following features in a 5020-

LNK mesh 

SNMP, Mobility Calibration Tool, 

Spectrum Analysis Tool, Gateway 

Server and Gateway Server 

Redundancy, Mobility, Radio 

Analysis Tool, Static and 

Automesh routing, Link 

Elimination, Multicast Groups, 

Ethernet Direct, Ethernet Loop 

Detection, External VRRP Support, 

and End to End Security 

If you use this procedure, you can manage the pair of nodes from HotView 

Pro. The computer used for management if configured correctly will not 

require a separate management license because the licenses will be stored 
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on the nodes. 

 

1. Download HotView Pro software from 

http://www.firetide.com/support/ software-downloads/ 

2. Install HotView Pro to an administrator computer. 

3. Start the HotView Pro Launcher. 

4. From the Options drop-down menu, select Manage Licensed HotPort 
Nodes. 

 

 

 

5. Go to File > Exit. 

6. To log into the HotView Pro server and client: 

a. Double-click the HotView Pro Launcher. 

b. Single-click the monitor/server icon to start the Quick Launch 

feature of HotView Pro, which opens the server and client software 

at the same time. 

7. When prompted, enter: 

- User Name: hv_admin 

- Password: firetide 

8. Click Log In. 

 

Certification requirement 

People who install and manage networks that contain Firetide products must 

complete the Firetide certification program. 

 

Doing tests on a HotPort 5020-LNK solution 

The next picture shows the test setup for a HotPort 5020-LNK solution. 

 

 

 

 

PoE+ 

Server node
 

 

OUT 

IN 

 

PoE+ 

 

OUT 

IN 

Client node

http://www.firetide.com/support/
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Switch 

To configure an edge node and do tests with HotView Pro software: 

1. Put the nodes on a table. 

2. Attach the Ethernet cable from the administrator computer to the server 

node. 

Note. The administrator computer must have an IP address on the same subnet 

as the node. The default IP address is 192.168.224.150. 

 

3. Attach the power cables to power sources as shown in the previous figure. 

Caution! You must use the power supply that comes with the node. If 

you use a different power supply, you void the product warranty. 

 

The power LED comes on. The node boots and is ready to use in one minute. 

4. Attach one antenna adapter and then staging antenna to Radio 1/Antenna 

connector 1 on each node. 

5. Download and configure HotView Pro. See “Installing and configuring 

HotView Pro software” on page 6. 

6. Go to Mesh > Add Mesh > login with the default user name and password. 

 

 

 

7. Make sure the nodes are visible in HotView Pro. 

The system should prompt you to set the country code. 

8. Set the country code for the node to change the device from a low-power, 

low range setting to a correct full-power operational mode. 

Caution: Make sure you configure the device for the correct country. If 

you do not configure the country correctly, the device might operate in a 

manner that is not legal or create problems with other wireless devices. 

! 

! 
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a. Select the country of operation from the drop-down list. 

b. Click Set Country Code Now. 

When you set the country code the system refreshes the mesh configuration 

and gives all visible nodes the same country code. For a few minutes the 

nodes might appear and disappear from the graphic mesh record in HotView 

Pro. 

c. Wait for three minutes for the system to finish the refresh. 

9. Configure the node as needed: 

- Configure the radio or radios. 

- Set the operational mode as needed. 

- Set the extended range feature if the distance between the nodes is 

more than 0.8 km (0.5 mile). 

Note: For information about specific features and the configuration process, see 

the HotView Pro Product Configuration Guide. 

 

10. Repeat steps 2 to 12 for the other node. 

11. Check the link throughput. For procedures, see the HotView Pro Product 

Configuration Guide. 

Note: If you are not able to get the mesh to send and receive data traffic indoors, 

see “Troubleshooting” on page 13. 

 

You are now ready to permanently install the nodes and antennas to a pole or 

mast for installation in the field. 

 

 

Power Consumption table 

Power input from DC supply: 24 W (Typical), 27 W (Max) 

Power input from PoE: 24 (Typical), 26 W (Max)
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HotPort 5020-LNK node installation 
After you do tests and configure the nodes, you are ready to install the nodes in 

a permanent outdoor location. 

The work process is: 

1. Collect all required tools. 

2. Make sure that no new safety hazards are present at the installation site. 

3. Prepare safety equipment and confirm earth ground procedures. 

4. Attach the nodes and antennas to poles that attach to a mast, tower, or roof. 

5. Install the node and antenna assemblies and other devices, such as cameras 

or access points to a permanent location. 

 

Tools required 

For a HotPort 5020-LNK solution, you need to have: 

• #2 Phillips screwdriver 

• Small adjustable wrench 

• Electrical tape and butyl mastic or silicone tape to weatherproof the 

connectors 

Other equipment you might need includes: 

• Ladder 

• Lift truck 

• Safety equipment 

 

Making sure the site is ready for installation 

Note: For more detailed procedures for an initial site survey, see the Firetide Best 

Practices  Guide. 

Before you install any equipment outside, check the entire site: 

• To identify possible hazards that might be new since the complete site survey 

• To identify the presence of objects that might cause interference for the 

radios 

 

Warning! Certified professionals must install Firetide products. If you 

do not install this equipment correctly, the equipment can be 

damaged, or you can be injured or die. 
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Electrical shock hazard warning! Make a plan to keep the installation 

personnel safe. 

 

Warning! Do not install Firetide products where possible contact with 

power lines can be made. Antennas, poles, towers, guy wires, or cables 

can touch power lines. People can be injured or killed if they touch or 

hold any part of the equipment when it contacts electric lines. Make 

sure that equipment and personnel cannot directly or indirectly 

contact power lines. 

 

Warning! Do not open the cover: 

•Dangerous voltages inside. 

•No serviceable parts inside. 

•Refer to qualified service personnel. 

 

Safe installation practices 

Best practice: Install HotPort 5020-LNK solution on poles that are far enough 

away from power lines. 

The horizontal distance from a tower, pole or antenna to the nearest power line 

should be at least twice the total length of the pole/antenna combination. This 

distance ensures that the pole will not contact a power line if it falls during or 

after installation. 

• Select equipment locations that allow safe and simple installation. 

• Do not work alone. 

• Use approved non-conducting ladders, shoes, and other safety equipment. 

Make sure all equipment is in good condition. 

• If a tower or pole begins falling, do not catch it. 

• If a wire or pole touches a power line, do not touch it. 

• Do not install antennas or towers on windy days. 

• Make sure all towers and poles are correctly grounded. Make sure all 

electrical cables connected to antennas have lightning arrestors. 

A connection to earth ground and a lightning arrestor can prevent fire 

damage or personal injury in case of lightning, static build-up, or short 

circuit within the equipment connected to the antenna. 

• Use 10 AWG ground wire and corrosion-resistant connectors to connect the 

base of the antenna pole or tower directly to the building protective ground 

or to one or more approved grounding rods. 

• Refer to the National Electrical Code for grounding information. 
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Preparing a node for outdoor installation 

It is easier to install all devices to one object, such as a pole, and then attach the 

pole assembly to the roof. If you attach the devices to a pole attached to the roof 

top, factors, such as weather, can make the installation more difficult and 

dangerous. 

Note: Install the antenna at the correct elevation recorded in the site survey 

report. The installation elevation can be higher or lower than the HotPort 

because the elevation is related to the link path calculations. 

     Warning! Only use antennas that are rated for outdoor applications. 

Warning! Failure to obey these instructions might result in severe 

personal injury including electrical shock or permanent damage to 

equipment. 

 

Warning! Make sure that all safety equipment is in good condition. Do 

not use broken or damaged tools or equipment. Always use safe work 

practices and obey all local and national guidance for earth ground 

requirements and electricity. 

 

For this procedure you need to have a copy of the antenna elevations from the 

site survey report and all tools. 

To prepare a node for outdoor installation: 

1. Make sure that you use the outdoor antennas that come with the HotPort 

5020-LNK solution. 

2. Remove the mount bracket from the node. 

a. Use the Phillips screwdriver to loosen the four captive screws (two 

on each side). 

 

 

 

 

 

 

 

 

Mount bracket 
 

Captive screws 

 

b. Remove the outer mount bracket from the hooks of the mount plate. 
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Mount bracket 

 

 

 

Hooks on mount plate 

 

Node 

 

 

c. Put the node in a safe place while you attach the bracket to a pole or 

wall. 

Note: Install the antenna at the correct elevation recorded in the site survey 

report. The installation elevation can be higher or lower than the HotPort 

because the elevation is related to the link path calculations. 

 

3. To a pole that you can install at a permanent outdoor site, attach these 

items: 

- Bracket for the node 

- Antenna bracket 

- (Optional) Other devices 

4. Attach the antenna to the antenna bracket. 

5. Attach the node to the bracket so that when it is in its permanent location 

the connectors are down, antenna connectors are on each side, and you can 

read the “Firetide” name. 

The installation is correct if the device does not move side to side easily, the 

“Firetide” mark is oriented correctly, and the connectors are oriented to the 

ground. 

 

Preparing earth ground 

Warning. A HotPort node must be correctly connected to earth ground. 

Failure to do so can result in equipment damage, injury, or death. 

The product warranty does not include damage from incorrect grounding. Obey 

all local building and electrical codes regarding antennas. If not available, refer 

to the National Electric Code (NEC). 

Earth grounding guidelines include: 

• If you attach a node and antenna to a tower or pole, attach the base of the 

tower pole to the building’s ground or to one or more approved grounding 

rods with 10 AWG ground wire and corrosion-resistant connectors. 

• Connect the grounding cable to rain gutters only if the rain gutter is 

connected to earth ground. 

• Ground rods are copper-plated and 1.8 to 2.4 meters (6 to 8 feet) long. 
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• Install all ground components in straight lines. If you must make a bend, do 

not make a sharp bend. 

• Earth-to-ground should be less than or equal to 10 ohms. 

• Some salt compounds are corrosive and can cause copper ground rods to 

corrode. 

To prepare the soil for ground rods: 

1. If the soil contains rocks or sand, insert the ground rods into the ground. 

2. Pull out the ground rods. 

3. Put in an approved ground enhancement material into the holes where the 

grounding rods go. 

4. Put in the ground rods. 

 

Grounding a HotPort node 

The certified installer is responsible for the calculation of the correct gauge of 

the wire to be used to ground a mesh node. The antenna cables that come with 

the HotPort 5020-LNK solution have integrated lightning arrestors. 

Prerequisite: correct gauge of ground wire 

Caution. If the structure to which the node is attached is not properly 

grounded, the node can be damaged by a power surge. 

To ground a HotPort node: 

1.  Calculate the correct gauge of wire to be used in this procedure. Refer to the 

National Electrical Code for grounding information. 

Caution. The certified installer is responsible for the correct calculation 

of the wire gauge and other accessories that might be required to 

ensure proper earth ground. 

 

2. 

a. Cut three correct lengths of the correct gauge of wire. 

b. 

c. Crimp the lug that holds with the wire for antenna connector 1. 

d. Crimp the lug that holds the wire from antenna connectors 1 and 2. 

. Crimp the lug that holds the wire from antenna connectors 2 and 3. 

! 

! 
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Ground wire from antenna 

connector 1 to 2 

 

Crimp here 

 

Ground wire from antenna 

connector 1 to 2 

 

h. Repeat for second radio (if present). 

3. Remove the ground screw from the bottom panel. 

4. Insert the ground lug for the enclosure. 

5. Tighten the ground screw to secure the ground lug to the node. 

 

 

 

 

 

Ground wire from 

antenna connector 3 

Ground wire from the 

mesh node enclosure 

 

 

 

 

 

 

Ground screw 

 

 

 

 

6. Crimp the lug that holds the wire from antenna connector 3 and the 

enclosure. 
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Connect to earth ground 

 

 

 

 

Caution! The wire in this picture might 

! 
not be the correct gauge for your 

application. Consult a certified installer 

for grounding materials for your 

application. 

 

 

Now you are ready to weatherproof the cable connections. 

 

Installing a node and antenna assembly 

The process to install a node to a mast or tower is the same as a roof installation. 

Note: Collect and take all tools and materials with you to the installation site. 

   Warning! Do not install this product on a windy or rainy day. 

To install a node and antenna assembly in a permanent outdoor location: 

1. Safely lift and carefully put the assembly on the roof. 

2. Attach the pole to which the node and antenna are attached to a mast, 

tower, or roof. 

- Attach the cables that have integrated lightning arrestors, or attach 

the cables and install lightning arrestors. 

- Make drip loops with cables. 

- Install all grounding equipment. See “Grounding a HotPort node.” 

3. Make all connectors weatherproof. See the Firetide Best Practices Guide. 

Caution. Do not use the 12 VDC power supply from a HotPort 7020 mesh 

node to power a HotPort 5020 node. The HotPort 5020 needs power 

from a PoE+ (802.3at compliant) or 15 VDC power supply. 

! 
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Caution. Do not use port 2 or port 3 of a HotPort 7020 mesh node to 

power a HotPort 5020 node. A HotPort 5020 node needs PoE+ or 

802.3at, and the ports of a HotPort 7020 mesh node are PoE 802.3af 

compliant only. 

 

4. (Optional) Attach the Power over Ethernet (PoE) assembly to power the 

device. 

Caution. Do not connect to more than one power source at one time. 

 

 

 

 

 

 

a. Put the correct end of the power cable into the PoE injector. 

b. Put the plug end of the power cord into a grounded AC power source. 

c. Attach an Ethernet cable from the wireless node to the IN port. 

d. Attach an Ethernet cable from the out port to the Ethernet 

connector of the node. 

5. Attach all other cables including the AC power cable if you do not use the PoE 

assembly. 

6. Cover all unused antenna connectors with 50 Ohm terminators. 

7. Supply power to both nodes. 

If PoE is connected correctly, the LED becomes a steady green color. 

When you give power to each node, they automatically make connections to 

each other. The nodes use the configuration that you created when you 

staged the network. 

8. Make the PoE connection weatherproof. 

 

Caution! The PoE injector is not for outdoor use. Do not expose the PoE 

injector to rain or direct sun. 

OUT 

IN 

PoE 

! 

! 

! 
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9. Ping the IP address of the node to make sure it works. 

 

Opening the mount bracket 

A HotPort 5020-LNK node comes with an assembled two-piece mount bracket. 

The next picture shows a radio-side of a node and the assembled bracket. Two 

captive screws are on each side of the device. 

 

 

 

 

 

 

 

 

 

Captive screws 

 

The next picture shows the bracket pieces and orientation to the node. The 

mount bracket has multiple holes and slots, so you can use bolts, straps, or other 

materials to attach the node to a surface. 

Image A shows the side of the mount bracket on which the chassis is attached. 

Image B shows the bracket on which you hang the node. This bracket attaches to 

a pole or other surface. 

 

 

  

 

The mount kit includes extra nuts and bolts. 

Required tools: #2 Phillips screwdriver 

To open the mount bracket so you can attach the node to a wall or pole: 

1. Use the Phillips screwdriver to loosen the four captive screws (two on each 

side). 
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Mount bracket Captive screws 

 

2. Remove the outer piece from the hooks on the node. 

 

 

Rail on mount bracket 

 

 

 

Hooks on mount plate 

 

Node chassis 

 

3. Put the HotPort 5020 in a safe place while you attach the bracket to a pole or 

wall. 

4. Attach the mount bracket to a pole or wall. 

The next procedures list the steps to attach the bracket and node to different 

surfaces. 

 

Attaching the node to a wall 

Required materials: 

• Mount bracket 

• Four screws (included in the mount kit) or masonry anchors (not included in 

the mount kit) 

• Node with one bracket piece with hooks 

To attach a node to a wall: 

1. Use four screws or masonry anchors to attach the mount bracket securely to 

the wall. Put the screws or anchors in the two holes near the top and the two 

holes at the bottom of the bracket. 

2. Hang the node hooks on the rail. 

The installation is correct if the node does not easily move from side to side, and 

the connectors are oriented to the ground. 

Note: You can add other straps or a sling to increase durability of the attachment 

to the wall. 

Best practice: Use a spray to prevent corrosion on the bracket and mount 

hardware. 
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Attaching a node to a vertical pole 

Required materials: 

• Mount bracket 

• Mount kit 

• Node with one bracket piece with hooks 

Recommended tool: hex wrench (included in mount kit) or small adjustable 

wrench 

To attach the node to a vertical pole: 

1. Put the two U-bolts through the holes in the gripper. 

2. On each U-bolt, put a washer, a lock washer, and a nut. 

Note: A pole with a small diameter usually requires a second nut to hold the 

bracket away from the U-bolt. 

 

 

 

 

 

 

 

 

 

 

Hex wrench U-bolt 

 

Nuts for standoff 
Gripper 

 

3. Tighten the nuts by hand. 

The U-bolt should extend 12 to 15 mm (0.5 to 0.6 inch) beyond the second 

nut. 

4. Put on the second U-bolt and gripper. Use the bracket as a guide to correctly 

space the two U-bolts. 

5. Tighten the nuts with the hex wrench. 
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6. Use lock washers and nuts to secure the bracket to the U-bolts. 

 

 

 

 

Rails 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

7. Hang the node with the mount plate hooks over the rail of the bracket. 

 

 

Hooks 

 

 

 

 

 

 

 

 

 

The installation is correct if the node does not easily move from side to side, 

and the connectors are oriented to the ground. 

Note: If you need to, add other straps or a sling to increase durability of the 

attachment to the pole. 

 

Best practice: Use a spray to prevent corrosion on the bracket and mount 

hardware. 
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Attaching a node to a horizontal pole 

Recommended tool: hex wrench (included) or small adjustable wrench 

To attach the node to a horizontal pole: 

1. Attach the two grippers and U-bolts to the pole. Use the bracket to 

determine the correct space between the grippers. 

 

 

 

2. Use lock washers and nuts to secure the bracket to the U-bolts. 

3. Hang the node with the hooks over the rail of the bracket. 

 

 

Hooks 

 

 

 

 

 

 

 

 

 

4. With the Phillips screwdriver tighten the four captive screws to secure the 

node to the bracket. 

The installation is correct if the node does not easily move from side to side, 

and the connectors are oriented to the ground. 

Note: If you need to, add other straps or a sling to increase durability of the 

attachment to the pole. 

Best practice: Use a spray to prevent corrosion on the bracket and mount 

hardware. 
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Attaching straps 

You need to use straps when you use poles of 5 cm (2 inches) or more in diameter. 

You can also use straps for extra support and durability in corrosive 

environments. 

Straps are not included in the box. 

To attach the node to a pole with straps: 

1. Position the universal mounting bracket against the pole. 

2. Wrap two straps around the pole and thread them through the channels 

between the main piece of metal and the rails. 

 

Channels 

 

Rails 

 

 

 

 

 

 

 

3. Secure the straps. 

4. Hang the node with the hooks over the rail of the bracket. 

 

 

Hooks 

 

 

 

 

 

 

 

 

 

5. With the Phillips screwdriver tighten the four captive screws to secure the 

enclosure to the bracket. 

The installation is correct if the node does not easily move from side to side, 

and the connectors are oriented to the ground. 

Note: If you need to, add other straps or a sling to increase durability of the 

attachment to the pole. 

 

Best practice: Use a spray to prevent corrosion on the bracket and mount 

hardware. 
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Weatherizing the connectors 

The HotPort 5020-M node comes with a field-installable weatherized Ethernet 

connector. 

Correct weatherproofing includes: 

• Sealing all antenna connectors and antenna connector terminators 

• Installing the weatherized Ethernet connector 

• Using a spray to prevent corrosion on the bracket and mount hardware 

Weatherizing procedures, see Firetide Best Practices. 
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Troubleshooting 
If a HotPort 5020-LNK node does not operate correctly, try these suggestions. 

If you recorded the performance of your network when you set it up, you have a 

benchmark against which you can compare future performance. With benchmark 

information, you might be able to identify problem areas faster than if you try to 

diagnose a new problem. 

 

Cannot see a HotPort 5020-LNK node in HotView Pro 

First, you must turn on both HotPort 5020-LNK nodes at the same time so they 

can make a link and be detected by HotView Pro. 

Next, try the manual peer configuration procedure. 

If you cannot see one or more nodes in HotView Pro, make sure that you set the 

extended range and multiple hop feature. The extended range feature is for 

applications where nodes are 0.8 km (0.5 mile) or more apart. 

A cable somewhere along the network path might be bad. 

The node might not be receiving power. 

Forcing detection of a HotPort 5020-LNK node manually 

This procedure is for HotPort 5020-LNK point-to-point solutions. 

Prerequisites: 

• Administrator computer 

• Ethernet cable 

To make a connection when the link pair is not detected or do not link: 

1. Make sure that the power LEDs of both nodes are ON. 

2. Attach an Ethernet cable from one node to the administrator computer. 

3. Start HotView Pro. 

4. Enter the default login credentials: 

Username: hv_admin 

Password: firetide 

5. Go to Mesh > Add Mesh 

6. Enter the default login credentials: 

Username: admin 

Password: firetide 
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7. From the main workspace of HotView Pro, right-click the head node > Peer 
Node Configuration 

8. Enter the serial number of the node that you want to appear. 

9. Click Save. 

10. Remove the Ethernet cable from the first node, and attach it to the other 

node. That node is now the head node. 

11. From the node that you just configured, right-click the node > Peer Node 
Configuration 

12. From the main workspace of HotView Pro, right-click the head node > Peer 
Node Configuration 

13. Enter the serial number of the node that you want to appear. 

14. Click Save. 

 

After multiple reboots a node is missing 

If a node reboots five times within 10 minutes, the node loads the second saved 

firmware image. 

The previous firmware, if older or different from the firmware of the other nodes 

in a mesh network, might not be recognized by the mesh, and HotView Pro will 

not detect the node. 

To prevent this behavior, always upgrade the firmware image on each node two 

times, so both images are the same. 

 

Ethernet port LEDs blink quickly 

If the Ethernet port LEDs blink quickly, check for a switch loop. 

 

Performance not as expected 

If the network performance is not as expected: 

• Identify reuse in your channel plan. If you have no channel reuse in the 

network, do a spectrum analysis. 

• Check for self-interference. For example, the radios in a single device might 

connect. 

• Check the frequency plan and make sure that all the radios are configured 

correctly. 

• Make sure that each node is connected to the correct devices and nodes. 

• Determine the total throughput with an end to end test. 

• Determine the throughput of each link with tests. 

• Change the channel and modulation rates. 

• Overly strong or poor RSSI can cause low performance. The RSSI calculator 

can help determine what RSSI values are correct for a particular link. 

- For MIMO applications, use -30 to -55. 

- For non-MIMO applications, use -30 to -60 or -70. 
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Resetting a HotPort 5020-LNK node to factory 
default settings 

Do a reset when you remove a device from the field or when communication with 

a device is lost. 

Caution! When a HotPort 5020-LNK node is reset, configuration 

information is erased. 

Exception: The system does not erase the USA (840 and 842) country 

codes. 

You can reset a HotPort 5020 edge node with the reset button. The reset button 

is behind the screw on the left side of the port connector. 

For this procedure you need: 

• Paper clip, stiff wire, or thin piece of plastic or wood, such as a skewer 

• Computer with HotView Pro 

• Ethernet cable 

• Wrench or your fingers to turn the pressure valve counter clockwise 

To reset a HotPort 5020 edge node: 

1. Supply power to the node. 

Wait until the status LED comes on. After one minute, the node is ready to be 

reset. 

2. With a wrench or your fingers turn the pressure valve counter clockwise to 

remove it. 

 

 

 

 

3. Put it in a safe place until you finish this procedure. 

4. Put the node on its front panel. 

5. Press and hold for 20 seconds the reset button with the paper clip or other 

tool. 

When the Radio 1 LED blinks to indicate that the software is rebooting, you 

can stop pressing the reset button. 

6. Wait one minute, and then log in with HotView Pro. 

7. Configure the node or apply a previously saved configuration file. 

8. Replace the pressure valve that covers the reset button. 

 

Scheduling firmware upgrades and activation 

By default, the system uses the configuration in cache for multiple upgrades. 

! 
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Best practice: Upgrade the image two times because you want the backup image 

and primary images to be the same. If a backup image is older than the primary 

image, the node might not support the same features. 

You can: 

• Upgrade and activate the firmware now. 

• Upgrade the firmware now and activate it later. 

• Upgrade the firmware on a specified day at a configured time and then 

activate it immediately or later. 

By default, the scheduler activates the firmware immediately. 

If you select the Activate Later check box, the scheduler copies the firmware 

image to the node but does not activate the firmware. 

 

 

 

 

When you schedule an upgrade time (Scheduler Operation: Later), the HotView 

server, if it is running, starts the job at the scheduled time. If the HotView server 

is not running at the time scheduled, the scheduled jobs start immediately after 

you start the HotView server. 

Best practice: If you choose to upgrade a production mesh, schedule the 

upgrade and activation for a convenient time. Firmware upgrades can consume 

considerable bandwidth. The mesh is not available for two minutes when you 

activate new firmware. 

To schedule a firmware upgrade for a later date and for later activation: 

1. Go to Network > Upgrade Firmware 

The upgrade scheduler appears. 
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2. Click New Scheduler. 

a. Select Upgrade. 

b. Select the time: Later. Use the calendar to a future date and time. 

c. Click the tab to select a device type (HotPort Nodes for a mesh 

network, HotPoint Nodes for access points, or FMC for mobility 

controllers), and then select the mesh or device by ID or name. 

Note: The system selects all nodes within a mesh for simultaneous upgrade 

because all of the nodes have to run the same firmware. If a node should not 

receive the upgrade image, you can remove the mark from the upgrade check 

box. 

 

d. Select Activate Later. 
 
 

 

 

e. Select the upgrade image. 

3. Click OK. 

The “upgrade complete” message means that the image file is on the node 

and is valid. You can then activate a few nodes at a time until all of the nodes 

are running the same firmware version. 
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Replacing a HotPort 5020-LNK node 

If one of the HotPort 5020-LNK nodes stops working and the product is within 

the warranty period, you should call customer service for replacement options. 

Use these procedures to replace a HotPort 5020-LNK node. This procedure has 

two parts. First, you have to save a configuration file and make a configuration 

change to the operational node. Next, you have to apply the configuration file to 

the replacement node. 

Prerequisites: 

• One operational HotPort-LNK node 

• Ethernet cable 

• Administrator computer running Hot View Pro 10.10.0.0 or later 

Note: The operational HotPort-LNK node must run the same firmware as the 

replacement node. If the replacement node comes with a later firmware version, 

you must upgrade your operational node to use the same firmware before you 

begin. 

 

To prepare the operational node for a new link: 

1. Connect an Ethernet cable from the operational HotPort 5020-LNK node to 

the computer. 

2. Start HotView Pro. 

3. Go to Mesh > Add Mesh 

4. Log into the operational HotPort-LNK node. 

5. Save the configuration file of the node. 

a. Right-click the node > Save PTP Configuration from this HotPort 

b. Save the configuration file to a safe place. 

6. Configure the node to join a new node. 

a. Right-click the node > Peer Node Configuration 

b. Enter the serial number of the replacement HotPort node. 

7. Remove the Ethernet cable from the node. 

To add the replacement node: 

1. Connect the Ethernet cable to the replacement node. 

2. Go to Mesh > Add Mesh 

3. Log into the replacement node with the correct IP address and password. 

4. Right-click the replacement node > Apply saved PTP Configuration to this 
HotPort 

5. Right-click the replacement node > Peer Node Configuration 

6. Enter the HotPort serial number of the other node. 

7. Make sure the system makes a link between the HotPort-LNK nodes. You 

should see a green dotted line between the two nodes. A dotted green line 

indicates a wireless connection. 
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8. Remove the Ethernet cable. 
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Weatherproof procedures 
Cable connections become loose over time due to vibration. Loose connections 

let moisture contact and erode the interface to a connector. To avoid 

performance problems due to moisture damage, Firetide recommends that you 

use butyl mastic and electrical tape or silicone tape to make all outdoor 

connections weatherproof. 

The next picture shows correctly weatherproofed connectors on a HotPort 7020 

mesh node with a sun shield. 

 

 

 

 

Antenna with 

weatherproof connector 

 

 

 

 

 

 

 

Weatherproof 

connectors 

 

Mesh node with sun shield 

 

 

 

 

 

Best practice: You can use colored tape for easy identification of the connectors 

from the mesh node to the antenna. 

Butyl mastic is a synthetic rubber sealant that you can use to make a connection 

weatherproof. It is slightly sticky and stays flexible; it bonds to itself to make a 

good seal. Butyl mastic and a layer of electrical tape keeps the cable assembly 

clean, dry, and easy to change in the future. 

Note: To make a strong watertight connection, keep a high level of tension in the 

butyl mastic when you stretch it over the cable and connector. 
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Tools and materials to weatherproof connections 

To make a weatherproof connection you need the following tools and materials: 

• Pliers 

• Utility knife 

• Vinyl electrical tape 

Note: Vinyl electrical tape between the cable assembly and the mastic tape 

makes future changes easier than mastic tape put directly on the cable. Vinyl 

electrical tape as a cover over the mastic tape prevents the mastic from melting 

in hot weather. 

 

• Rubber splicing or mastic tape (also known as self-amalgamating, self- 

sealing, self-fusing, non-vulcanized tape) 

• Pencil or wooden dowel for small clearances 

• Cleaning supplies (if necessary) 

• Laptop running HotView software 

 

Making a weatherproof antenna connection 

You need to put tape around the antenna connectors to make them 

weatherproof. The next picture shows correct tape technique and a drip loop. 
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To make a weatherproof antenna connection: 

1. Gather the tools and materials to do the procedure. 

 

 

 

Mastic tape 

 

 

 

 

 

 

 

 

 

 

 

2. Ensure that the cable and connector is clean. Clean off oil, water, grease, and 

dirt before you continue. 

3. Attach the cable connector to the antenna connector, and then use pliers to 

tighten the connection. 

4. With a laptop running HotView Pro, make sure that the Firetide device works. 

5. Wrap a layer of electrical tape (sticky side out) over the connector from the 

end to approximately 2.5 cm (1 inch) of cable. Overlap the tape by 40% with 

each turn. 

Note: Wrap the electrical tape on a pencil or wooden dowel when you have little 

clearance. 

 

 

 

 

 

Note: To make a strong watertight connection, keep a high level of tension in the 

butyl mastic when you stretch it over the cable and connector. 

 

6. Tightly wrap a layer of mastic tape over the electrical tape. Make a 40% 

overlap on each turn. Start from the base of the unit to at least 2.5 cm (1 

inch) of the cable. 



Weatherproof procedures 

 

38  

 

 

 

 

 

 

7. Wrap a layer of electrical tape (smooth side out, sticky side in) over the 

mastic tape. 

 

 

 

 

8. Wrap a second layer of electrical tape over the first layer of electrical tape. 

The antenna connector is ready for installation in an outdoor environment. 

Making a weatherproof cable to node connection 

You need to make weatherproof two connections: 

• From the antenna cable to the lightning arrestor 

• From the lightning arrestor to the node 

To make a weatherproof cable to node connection: 

1. Gather the tools and materials to do the procedure. 
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Mastic tape 

 

 

 

 

 

 

 

 

 

 

 

2. Remove the sun shield because you must put tape around all of the 

connector. 

3. Ensure that the cable and connectors are clean. Clean off oil, water, grease, 

and dirt before you continue. 

 

 

 

 

4. Wrap a layer of electrical tape (sticky side out) over the arrestor to node 

connector and wrap approximately 2.5 cm (1 inch) of cable. Overlap the tape 

by 40% with each turn. 

 

 

 

 

 

5. Repeat for the antenna cable to arrestor connection. 
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Note: To make a strong watertight connection, keep a high level of tension in the 

butyl mastic when you stretch it over the cable and connector. 

 

6. Tightly wrap a layer of mastic tape over the electrical tape. Make a 40% 

overlap on each turn. Start from the base of the unit to at least 2.5 cm (1 

inch) of the cable. 

 

 

 

7. Wrap a layer of electrical tape (smooth side out, sticky side in) over the 

mastic tape. 

 

 

 

 

8. Wrap a second layer of electrical tape over the first layer of electrical tape. 

The lightning arrestor connections are ready for installation in an outdoor 

environment. 




